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License 

 
Revision Date: 1 February 2010 

 
Copyright © 2010 Edgeware Technologies (India) Pvt. Ltd.   All Rights Reserved. 
Permission is granted to copy, distribute and/or modify this document under the terms of the 
GNU Free Documentation License, Version 1.3 or any later version published by the Free 
Software Foundation; with no Invariant Sections, no Front-Cover Texts, and no Back-Cover 
Texts. A copy of the license is included in the section entitled "GNU Free Documentation 
License".  

 VistA-Edge™ is a trademark of Edgeware Technologies (India) Pvt. Ltd.  Other trademarks 
are the property of their respective owners. 
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Introduction 
 
The VistA-Edge™ PMS is designed to register patients for a visit, to schedule patient visits 
(creating and canceling appointments) and capture billing data sent from VistA to generate Form 
CMS-1500 for billing. 
 
VistA-Edge™ PMS is can also be used independent of VistA, by manually entering the billable 
services provided to the patient. 
 
 

 
 
 
  Figure 1: Data Flow diagram 
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The Open Source HL7 Engine - Mirth is used to send Patient registrations and appointments to 
VistA. The appointment interface assumes that the ‘Providers’ setup in the PMS is mapped to 
the required Clinics in VistA. Details on Location mapping can be found later in this manual. 
 
Mirth is also used to receive, billing details (Procedures and Diagnosis) entered in CPRS, sent 
out from VistA. 
 
This manual is organized in the way most people will use the “Practice Management System”.  
It begins with how to log on to the system and how to work step by step on different tasks you 
will perform. 
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Working with the system 

 
Logging in to the VistA-Edge™ PMS 
 
On startup the following Login screen will pop up. 
 
Enter the User Name and Password and click the ‘OK’ button to log in. The default login 
credentials are: 
 
Username: admin 
Password:  admin 
  
Note: Password is case sensitive. 
 

 
  

 
 
 
 
 

3. Click  
‘OK’ 

1.Enter the 
user name. 
 

2.Enter the 
password. 
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The Main Screen 
 
After successful login, the Main screen, as shown below, will be visible. The Screen title will 
Display the username of the login account used. 
 
This screen has various menus: 

• The File Menu,  

• Masters Menu,  

• Transactions Menu, 

• Reports Menu, and 

• Help Menu 
 

In addition to the Menu’s there are quick links to frequently used options made available on the 
main screen. 

 
Each Menu has different options under it. 
 
 
 
 
 
 

 

Menu’s to 
perform a 
specific 

task.  
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The Quick links provided include: 
 

• Provider 
 

• Facility 
 

• Insurance 
 

• CPT-ICD 
 

• Chargecode 
 

• Registration 
 

• Appointment 
 

• Pre Claim Info 
 

• Generate Claim 
 

• Payment 
 

• Unposted 
 

• Receipt 
 

• Help – link to the User Manual 
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The File menu 

 
On clicking the ‘File’ Menu, the ‘User Management’ and ‘Exit’ option will be displayed as seen 
below: 
 

 
 
 
The User Management Option can be used to create additional users, delete existing users and 
to change password of users in the system. The system comes with a default super user named 
‘admin’ with password ‘admin’. There are two possible levels of users in the system: 
 

1. Normal User – cannot create or reset any additional users passwords.  
 
2. Super User – Can create additional users of both user levels. 
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• Add user(s) - To add a user to the system enter the username, password, choose the User 
Level and click the ‘Add’ button. 

 

• Search user(s) – To search for an existing user enter the username and click the ‘Search’ 
button.  

 

• Change password – After searching for the user whose password is to be reset, use the 
‘Click here to change password’ link to reset the user password. Enter the new password 
and use the ‘Update’ button to save changes. 

 

• Delete User - After searching for the user whose account is to be deleted, use the 
‘Delete’ button to remove the user from the system. 

 

Use add button 
to add new user 
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The ‘Exit’ option as the name suggests can be used to close and exit from the PMS system. 
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The Master Menu 

 
Clicking the ‘Master’ Menu, will display following options as seen below: 
 

1. Provider 
2. Facility 
3. Insurance Company 
4. CPT-ICD Link 
5. Charge Codes 
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Provider option 
 
On clicking the “Provider” option, the following screen pops up.  
 
This screen is used to add the details about the Provider in the system. 
 
  
 
 

 

1. Enter Code, 
which is 
unique for 

each provider. 

2. Enter details 
about the provider 
like last name, first 
name, address, city, 
NPI, IDs and 
credentials, etc in 
the respective 

boxes. 

3. Click on 
Save Button to 
save the given 
information in 
Provider 
Master Table. 
 

Click on Search 
Button to search for 
existing records 
from the Provider 
Master Table, if 

already entered. 
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Facility Option 
 
On clicking the “Facility” option, the following screen pops up.  
 
This screen is used to enter the Address and other details of the Facilities and Revenue center. 
 

 
 
 

 
 
 
 
 
 
 
Billing Facility: To indicate if the Facility is to be included as a Billing Provider/Facility 
(section 33 on the 1500 Health Insurance Claim Form) 
 
Service Facility: To indicate if the Facility is to be included as a Service Facility (section 32 on 
the 1500 Health Insurance Claim Form) 
  

3. Click on Save 
Button to save the 
given information in 
Facility Master 

Table. 

2. Enter the 
facility name 
and other 

details.  

1. Enter 
Unique Charge 
Code. 

Click on Search 
Button to search 
for the existing 
records from the 
Facility Master 

Table. 
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A facility can be created as a Billing Service, a Service Facility, or as both depending on the 
requirement. 
 

Insurance Company option 
 
On clicking the “Insurance Company” option, the following screen pops up.  
 
This screen is used to add the details about the various Insurance Company(s) of patients in the 
system. 
 

 
 
 
 
 
The Insurance Company Master contains the following fields: 
 
� Company Details Section 

 

• Code – Enter a unique value assigned to every insurance company. 

• Type – From the drop down menu type of insurance is selected. For example 
Medicare, Medicaid, BCBS etc.  

• Name – Enter the Name of the insurance company. 

• Address- Enter the Address 

• Zip- Enter the Zip code. 

• City- Enter the City 

• State- Enter the State. 

 Click on Search Button to search for the existing                      

records from the Insurance Company Master Table. 
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• Fax- Enter the Fax Number. 

• Phone- Enter the Phone Number. 

• Contact Person: Name of the contact person in the insurance company. 
Click on the “Save” button to save the Insurance Company details. 

 
CPT-ICD Link option 
 
On clicking the CPT-ICD Link, the following screen will be available. From here we can select 
CPT’s in the database and link it with corresponding ICD(s). This information once entered can 
be used in the ‘Generate Claim’ screen to link the CPT’s sent from VistA or entered manually 
for claims. 
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Charge Code option 
 
On clicking the “Charge Codes” option, the following screen pops up.  
 
This screen is used to select the billable services provided by the doctor. It is mandatory to have 
charge codes associated with the CPT codes used to be able to add them on the patient Bill for a 
claim. 
 

 
 
 
 

 

 
 
 
 
 
 
 
 
 
 
 

1. Enter 
Unique Charge 
Code. 

2. Click on down arrow 
and choose CPT Code 
from the list of CPT 
Codes, it will display 
the description of that 
code. Follow the same 
process for rest of the 

list boxes on the screen. 

4 Click on 
save button to 
save the 
information 
in Charge 
Code Master 

Table. 

3. Enter the 
Description of 
Charge Code. 
Similarly enter 
for the rest of 
the descriptions 

fields as well. 

5. Enter 
Comments and 
Price. 
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The “Search” button can be used to lookup specific charge codes, if searched according to the 
parameters selected in the screen. If no parameter is selected or the screen is reset, then clicking 
the “Search” button will display the complete list of stored charge codes. The “Search” button 
functions in the same way in other Master options as well, i.e, Facility, Insurance Company and 
Provider Masters. 
 
NOTE: Due to licensing issues, CPT codes have not been added to the Database.
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The Transaction Menu 

 
Clicking the ‘Transaction’ Menu will display five options as seen below: 
 

1. Patient Registration 
2. Appointment 
3. Pre-claim info  
4. Generate Claim 
5. Payment Posting 
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Patient Registration option 
 
On clicking the “Patient Registration” option, the following screen pops up.  
This screen is used to register the patients by adding their details in the system. 
 
The screen has the following three tab buttons: 
 

1. Basic Demographics 
2. Additional Demographics 
3. Insurance Coverage(s) 

 
 

 
 
 
 
 
 
 

2.After entering the 
required details about the 
patient, click on the save 
button to register the 
patient. 

1.Enter the last name, first 
name, sex and other relevant 
information about the patient 
in the boxes. 

Click on this button if 
you want to search for 
the already registered 

patient. 
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We can register a patient by filling all the mandatory fields in all the demographics tabs, marked 
as (*) .If we try to register a patient without entering any of the mandatory fields, then it will 
display an error message and the patient will not get registered. A unique patient ID is generated 
by the system, which will be used in VistA as well. 
 
The patient registration screen also has an option for searching registered patients. 
 
On clicking the “Search Patient” button on this screen, the following screen will pop up. 
We can edit/update the patient information by selecting the patient by using the “Search Patient” 
Button. 
 

  
 
 

 
 
 
 
 
 
 
 
Once the patient has been added to the system, the patient demographics can be updated as and 
when required. 

 
 
 
 

 

2.Click on this button if 
you want to make a new 
registration. Clicking 
this button will take you 
to the patient 

registration screen.  

1.After entering the 
Search Parameters, 
click the ‘Search’ button 
to search for the 

required patient. 
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Additional Demographics tab 

 
On clicking the “Additional Demographics” tab, the following screen is made available.  
 
This screen has the option for storing more information about the patient. 
 
 

 
 
 
 
 
 
 
 

 

1.Enter all the required 
details about the patient 
like Address, Phone No., 
religion, nationality, etc in 
the respective boxes. 

2.Click on the save button to save 

the information about the patient. 
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Insurance Coverage(s) tab 

 
On clicking the “Insurance Coverage(s)” tab, the following comes up.  
 
This screen is used for storing the Insurance Coverage(s) details of the patient for different 
Insurance companies and assigning them as Primary, Secondary or Tertiary. It also has the 
option for storing information about the Policy Holders. 
 
 

 
 

 
 
 
 
 
 
 
 

1.Select the Company and the Plan Type from 
the down menu and enter other relevant 
details like Policy Type, Source, Policy 
Holder's details, etc in the respective boxes. 

2.Click on the save 
button to save the 
Insurance Coverage(s) 

details of the patient. 
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Appointment option 
 
On clicking the “Appointment” option, the following screen pops up. To lookup patients, click 
the “Search Patient” button. Once the patient is selected choose the concerned provider from the 
“Provider” drop down box, enter the appointment date and time, click the “Book” button to 
create the appointment. 
 
For new patients, we have to first register them by clicking the “New Registration” button before 
making the appointment. 
 

 
 
 
 
 
 
 
 
 
 

1.Click on ‘Book’ 
button to Book 
an appointment 
for the required 

patient. 

2.Click on the 
save button to 
save the 
Encounter Details 

of the patient. 
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The Visit details section allows the entry of ‘Check in Time’ and ‘Check out time’. 
 
Please note: If the VistA-Edge™ PMS is not interfaced with VistA (that is the PMS is being used 
independently for Billing), when the patient arrives at the clinic, the Encounter Time is to be filled in, 
using this screen. 
 

Pre Claim Info option 
 
On clicking the “Pre Claim Info” option, the following screen pops up.  
 
This screen is used to store the visit details of the patient with the concerned provider. After the 
appointment has been made and the doctor sees the patient, a Visit Number is created. After 
filling the details mentioned on the screen, a Case Id is generated. The software will 
automatically assign the Case ID for the first case as “HRN.001”,  “HRN.002” for the second 
visit, so on and so forth. 
 
Only after the Case for the patient is created can the ‘Generate Claim’ option be used for 
generating the claim. 
 

 
 
 
 

 
 
 
 
 
 

1.Click on this 
button to 
search for the 
required 

patient. 

2.Enter the required details like 
Patient Condition details, 
Current Illness, Facility, Billing 
Service, etc about the patient in 
the respective boxes. 

3.Click on the 
save/update 
button to save 
the visit details 

of the patient. 
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Generate Claim option 
 
On clicking the “Generate Claim” option, the following screen pops up. This screen is used to 
store the billing information. Once the patient is selected, the ‘Patient Demographics’, Insurance 
Details and ‘List of Visits’ will be populated. 
 
Select the Visit for which the CMS 1500 form is to be generated. The ‘Encounters of’ drop down 
box can be used to filter the List of visits, for those received from VistA, entered in the PMS, or 
both.  
 
Note: Please refer to Annexure 1 for details on how the Billing details are captured and sent 
from VistA 
 
In Case billing data is not received from VistA, they can be entered using this screen. First select 
the visit and then enter the CPT and ICD codes to be billed for the selected visit. 
 

 
 
 
 
 
 
 
 
 

1.Click on this 
button to 
search for the 
required 

patient. 

2.Enter the CPTs and 
select the ICDs from 
the drop down menu 
box of the ICDs. 

3.Click on the save 
button to save the 

Billing information. 
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Populated ‘Generate Claim’ Screen: 
 

 
 
 
 
 
 
 
The Visit Date is the date of service.  
 
To Generate the CMS Form 1500  
  

• If PMS is not interfaced with VistA: 
 

o Select the Visit (created using the ‘Pre-Claim info’ option) 
o Enter the CPT code for the procedures performed on the patient during the visit. 

To do so single click the first field in CPT column and type the appropriate CPT 
o Enter additional details (Units of procedure etc.) 
o Assuming that the CPT-ICD Link master is in place, the possible ICD codes can 

be selected for each entered CPT Code by clicking the drop down menu under 
ICD. 

o Assuming that the Chargecode master is updated, select the appropriate 
Chargecode for each CPT/procedure. 

o The charges will be picked up and total calculated automatically. 

‘Encounters of’ 
drop down The ‘ICD’ 

block  
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o Use the ‘Save’ button to save the claim data entered. This will enable the ‘Print 
Claim’ option.  

o Use the ‘Print Claim’ option to print the HCFA 1500 form. 
 

• If billing information is sent from VistA: 
 

o To see the list of CPT’s sent from VistA only select ‘VistA’ from the ‘Encounters 
of’ drop down box. 

o The List of Diagnoses sent from VistA will be displayed in the ICD Block. 
o Click on the ‘CPT’ column to see and select the each CPT to be added to the 

Claim. 
o For each CPT selected, add the related ICD, units, chargecode and other details. 
o The charges will be picked up and total calculated automatically. 
o Use the ‘Save’ button to save the claim data entered. This will enable the ‘Print 

Claim’ option.  
o Use the ‘Print Claim’ option to print the HCFA 1500 form. 

 
This form after a thorough check can be printed on a CMS 1500 FORM, which can be sent to 
the concerned payer. 

 
Sample CMS-1500 Form 
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Payment posting option 
 
This option can be used to enter the receipts of payments into the system and to post the 
corresponding amount to the patient claim. 
 
 
Depending on the Payer is Insurance the details of the specific insurance company can also be 
linked to the receipt. 
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The Reports menu 
Clicking the ‘Reports’ Menu will display two options as seen below: 

 
1.  Detailed Receipt Report 

(a.) Receipt Report 
(b.) Unposted Receipt Report 
 

 
 
Receipt Report: 
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On selecting the report to print, the user can enter the date range for which the report is to be 
generated. 

 
 
Unposted Receipt Report:  
 

 



Edgeware Technologies           VistA-Edge™ PMS 

 

 

Page 34 of 40 
 

The Help menu 
 
Clicking the ‘Help’ Menu will display two options as seen below: 
 

1. Contents 
2. About 

 

 
 
Clicking the ‘Contents’ option will open up the “VistA-Edge™ PMS User Manual”. 
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About option 
 
On clicking the “About” option, the following screen pops up.  
This screen will display the information about the product and the contact details for any type of 
support required. 
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Annexure I  
 
Enter Encounter Details in CPRS 
 
Once logged in to CPRS, go to the ‘Notes’ Tab and click the “New Note” button to enter a note. 
Select a suitable note title. 
 

 
 

 
 
This will open a blank note as can be seen in the screenshot below 

Notes Tab 

New Note 
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Click the ‘Encounter” button to invoke the Encounter form. Enter the Diagnosis and 
procedure(s) for the Encounter using the respective tabs. 
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Ensure you assign a provider for the procedures documented in the Encounter. 
 

 
 
Click ‘OK’ when you have finished entering the Encounter details. This will show a popup to 
confirm the primary provider for the Encounter. If you are the primary provider click ‘yes’ or 
use the “Select Primary” button to select the Primary provider for the visit. 
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The details entered in the Encounter form will be visible in the bottom of the Notes block. 
 

 
 
Add the relevant text to your note (can be done using templates) and Sign the note. 
 

 
 

Encounter Details 
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On signing the note the Diagnosis and Procedure information entered in the Encounter form are 
sent out of VistA to the VistA-Edge™ PMS, assuming that the interface is setup and functional 
 


